PeopleSoft

Faculty/Staff Training
TABLE OF CONTENTS

Viewing Class Schedule.................................................................1
Accessing Class Rosters...............................................................3
Record Grades.................................................................................5
Input Class Attendance.................................................................8
Permissions (Blue Slip Functions)..................................................10
  To remove a permission............................................................12
Service Indicators: Including Holds & Flags....................................13
  To add and delete a service indicator..........................................14
View Student Address/Telephone..................................................15
UNO Class Roster............................................................................18
  Importing a Class Roster into Microsoft Excel..............................20

TRAINERS

<table>
<thead>
<tr>
<th>Rhonda Regan</th>
<th>Susan Baragona</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC-101Q</td>
<td>CC-101Q</td>
</tr>
<tr>
<td>504-280-5645</td>
<td>504-280-1263</td>
</tr>
</tbody>
</table>
Viewing Class Schedule

Navigate: Home > SA Self Service > Learning Management > Home > Learning Management > View My Class Schedule

Next, select the term you wish to view.

View My Class Schedule

Ima Instructor

Select the term for which you would like to see your Class Schedule.

Term

2006 Fall

Return to Learning Management
Your **class schedule** will be displayed.

### View My Class Schedule

**Ima Instructor**

2006 Fall

<table>
<thead>
<tr>
<th>Class Number</th>
<th>Subject</th>
<th>Catalog</th>
<th>Sect</th>
<th>Component</th>
<th>Start Time</th>
<th>End Time</th>
<th>Meeting Days</th>
<th>Building</th>
<th>Room</th>
</tr>
</thead>
<tbody>
<tr>
<td>13420</td>
<td>ANTH</td>
<td>1010</td>
<td>721</td>
<td>LEC</td>
<td>7:10PM</td>
<td>9:50PM</td>
<td>Tu</td>
<td>Jeff Ctr</td>
<td></td>
</tr>
<tr>
<td>10080</td>
<td>ANTH</td>
<td>2052</td>
<td>001</td>
<td>LEC</td>
<td>9:30AM</td>
<td>10:45AM</td>
<td>MW</td>
<td>Lib Arts</td>
<td>140</td>
</tr>
<tr>
<td>13022</td>
<td>ANTH</td>
<td>3370</td>
<td>001</td>
<td>LEC</td>
<td>2:00PM</td>
<td>3:15PM</td>
<td>TuTh</td>
<td>Lib Arts</td>
<td>256</td>
</tr>
</tbody>
</table>

*Select a different term*  
*Return to Learning Management*
Accessing Class Rosters

Navigate:  Home > SA Self Service > Learning Management > Home > Learning Management > Access Class Roster

Next, select the term you wish to view.

Access Class Rosters

Ima Instructor

Select the term for which you would like to view your roster.

Class Rosters

2006 Fall

Return to Learning Management
Select the course you wish to view.

The **Class Roster** page will be displayed listing all students enrolled in this course. You can change the **enrollment status** to view students who have dropped or are waiting for enrollment. You can also print this roster by clicking the printer icon from your internet browser toolbar.

<table>
<thead>
<tr>
<th>Name</th>
<th>Enrollment Status</th>
<th>Student ID</th>
<th>Short Description</th>
<th>Units</th>
<th>Primary Academic Program</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alexander, Lionel Matthew</td>
<td>Enrolled</td>
<td>2228403</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Brown, Patricia</td>
<td>Enrolled</td>
<td>2188224</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Brown, Ashley Dawn</td>
<td>Enrolled</td>
<td>2158521</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Bryant, Corey K</td>
<td>Enrolled</td>
<td>2228595</td>
<td>3.00</td>
<td>Business Admin Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Collins, Sharen</td>
<td>Withdrawn from Class</td>
<td>2008036</td>
<td>3.00</td>
<td>Education Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Edwards, Ryan Christopher</td>
<td>Withdrawn from Class</td>
<td>2177892</td>
<td>3.00</td>
<td>Liberal Arts Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Fries, Corinne Jo</td>
<td>Enrolled</td>
<td>2227074</td>
<td>3.00</td>
<td>Business Admin Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Gauthier, Kelly Ann</td>
<td>Enrolled</td>
<td>2222033</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Hyman, Brittany</td>
<td>Enrolled</td>
<td>2222374</td>
<td>3.00</td>
<td>General Studies Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Jatia, Tanzeal Rahman</td>
<td>Enrolled</td>
<td>2260953</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Kretlow, Rachel Field</td>
<td>Enrolled</td>
<td>2002465</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Manuel, Zara K</td>
<td>Enrolled</td>
<td>2196414</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Parrillo, Danielle Dominga</td>
<td>Enrolled</td>
<td>2147273</td>
<td>3.00</td>
<td>Business Admin Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Price, Edward Joseph</td>
<td>Withdrawn from Class</td>
<td>2208880</td>
<td>3.00</td>
<td>Business Admin Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Roland, Shelly Ann</td>
<td>Withdrawn from Class</td>
<td>2157986</td>
<td>3.00</td>
<td>Liberal Arts Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Rush, Lawrence Joseph</td>
<td>Enrolled</td>
<td>2297170</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Scarsone, Andrew Joseph</td>
<td>Enrolled</td>
<td>2218607</td>
<td>3.00</td>
<td>Engineering Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Semanayake, Jehan Moinanj</td>
<td>Withdrawn from Class</td>
<td>2223909</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Shrestha, Venkat Krishnam</td>
<td>Enrolled</td>
<td>2158390</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Snowater, Zachary Anderson</td>
<td>Enrolled</td>
<td>1818818</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Taylor, Mary Elizabeth</td>
<td>Enrolled</td>
<td>1617951</td>
<td>3.00</td>
<td>Sciences Undergraduate</td>
<td></td>
</tr>
<tr>
<td>Warner, Xuan Edmond</td>
<td>Enrolled</td>
<td>2141744</td>
<td>3.00</td>
<td>General Studies Undergraduate</td>
<td></td>
</tr>
<tr>
<td>York, Millie Caroline</td>
<td>Enrolled</td>
<td>2226474</td>
<td>3.00</td>
<td>General Studies Undergraduate</td>
<td></td>
</tr>
</tbody>
</table>
Record Grades

Navigate: Home > SA Self Service > Learning Management > Home > Learning Management > Record Grades

Learning Management

- Management
  - Review your class schedule information, view your class rosters and enter grade information.
  - View My Class Schedule
  - View My Weekly Schedule
  - Access Class Roster
  - Record Grades
  - Input Class Attendance

- Advisement
  - Review advisee information, transcripts and degree progress reports.
  - View Advisee Information
  - New Drop-In Advisees

- Course Catalog and Schedule
  - View course catalog information and look for specific class sections.
  - View Course Catalog
  - View Schedule of Classes

Next, select the term you wish to view.

Record Grades

Ima Instructor

Select the Term for which you wish to view a roster.

Grade Rosters
- 2006 Fall

Return to Learning Management
The **Select Grade Roster** page will be displayed. Select the course for which you will be entering grades.

![Select Grade Roster](image)

The **Grade Roster** page will be displayed. Verify the **Roster Type** is correct for your particular grade entry (if entering mid-term grades the roster type should reflect “mid-term”; if entering final grades be sure the roster type indicates “final grade”). To change the roster type, click the **next row** button.

![Grade Roster](image)

The students are listed in alphabetical order by last name.
Generally, mid-term grade entry is only required for freshmen. All mid-term grades should be saved with the approval status set as not reviewed.

However, for final grade entry, the grades must first be saved as not reviewed, and then the approval status should be changed to approved and saved again.

For more detailed instructions on entering Mid-Term and Final Grades, visit the PSTRAIN website at http://pstrain.uno.edu/ and select Entering Mid-Term Grades or Entering Final Grades under the Popular Documents section.
Input Class Attendance

Navigate: **Home > SA Self Service > Learning Management > Home > Learning Management > Input Class Attendance**

**Learning Management**

- **Management**
  - Review your class schedule information, view your class rosters and enter grade information.
  - View My Class Schedule
  - View My Weekly Schedule
  - Access Class Roster
  - Record Grades
  - **Input Class Attendance**

- **Advisement**
  - Review advisee information, transcripts and degree progress reports.
  - View Advisee Information
  - New/Drop-in Advises

- **Course Catalog and Schedule**
  - View course catalog information and look for specific class sections.
  - View Course Catalog
  - View Schedule of Classes

**Change User Preferences**

Next, select the term you wish to view.

**Class Term Selection**

Instructor, Ima  

**Choose Class Term**

- 2006 Fall
The **Class Selection** page will appear. Select the appropriate course for which you want to enter attendance.

<table>
<thead>
<tr>
<th>Course Title</th>
<th>Subject and Catalog Nbr</th>
<th>Class Section</th>
<th>Class Nbr</th>
<th>Institution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Peoples of the World</strong></td>
<td>ANTH 1010 T21</td>
<td>13420</td>
<td>University of New Orleans</td>
<td></td>
</tr>
<tr>
<td><strong>Cultural Anthropology</strong></td>
<td>ANTH 2052 001</td>
<td>10080</td>
<td>University of New Orleans</td>
<td></td>
</tr>
<tr>
<td><strong>People Culture Pacific</strong></td>
<td>ANTH 3370 001</td>
<td>13022</td>
<td>University of New Orleans</td>
<td></td>
</tr>
</tbody>
</table>

The **Class Attendance Roster** page will be displayed and allows you to document the student’s attendance and the date they last attended. After making all appropriate entries, scroll to the bottom to save.
Permissions (Blue Slip Functions)

UNO uses student-specific permissions. A student’s ID is added to a class (preventing a student from sharing a permission “number”). This function is generally completed by the secretary or counselor within each department.

Assigning permission, does not add the class to the student’s schedule. Once you have assigned the permission, the student must personally add the class to their schedule.

Navigate: Home > Manage Student Records > Establish Courses > Use > Class Permission Numbers

This opens a window allowing you to search for the course.

![Class Permission Numbers Window](image)

**Academic Institution:** Will default to UNOLA.

**Term:** Enter the four-digit semester code or select from the lookup list.

**Subject Area:** Enter the abbreviation of the course (e.g. ENGL, CHEM) or select from the lookup list.

**Catalog Number:** Enter the four-digit catalog number for the course. *(Hint: If you are looking for “Intro to Entrepreneurship” but do not know the catalog number, you can enter “BA” as the subject area, then click to the right. All available courses for will appear, allowing you to find the particular course.)*

Click **Search**.
Use the next row and previous row buttons to see the class section of the course for which you are assigning this student permission.

In the bottom portion of this page, you will see all the students who have been assigned permission to enroll in this class, as well as whether they have used this permission and actually added the class.

If there are already one or more students that appear for this section, you must click the Add New Row button to insert a new row to add additional students. Do not type over an existing ID number.

**Default Date:** will default to today’s date.

**ID:** Enter the student’s ID. If unknown, click and search using SSN (National ID) and/or first and last name.

**Expire Date:** This is the date the permission expires. It will default to tomorrows date and generally this should be left alone. However, under special circumstances, this date may be changed. Clicking the calendar icon for this field will allow you to change the expiration date.

**Click .**
To Remove a Permission

- To remove a permission, navigate **Manage Student Records > Establish Courses** > **Use > Class Permission Numbers** and scroll to the correct **class section** using the **next row and previous row** buttons.
- Locate the student’s ID and name on the bottom portion of the page.
- Check next to the **Seq #** column to see whether or not the student has already added the class. If not, you can remove the permission.
- To remove their permission (to keep them from enrolling in the class):
  - Click the Delete Row icon to delete the row.
  - Click **Save**.

**Keep in mind that permissions can be powerful, so use them carefully.**

Permissions can:

- Let a student into a full class
- Let a student into a consent of department class
- Let a freshman into a graduate course, etc.

Permissions will **not**, however, allow a student to take more classes than their unit load dictates. For most students the maximum unit load is 19 credit hours and a permission will not allow them to take any classes over that limit.
Service Indicators: Including Holds & Flags

Service indicators are used to provide further information on a student. Often, they are used to prevent the student from an action, such as registering.

Navigate: Home > Manage Student Records > Manage Academic Records > Use > Service Indicator Data

Enter the student’s ID or use the fields below to search by SSN (National ID) and/or first and last name. Click **Search**. A page will open allowing you to add or remove service indicators.

Note: You can only add or remove those service indicators for which you have security permission levels.
To Add a Service Indicator

If there is already a service indicator documented, you must first insert a new row to add another one. Do not type over an existing service indicator code.

**Service Ind Active Term:** The term will default to 0000, which means start now, but you can enter or select a specific starting term.

**Service Indicator Cd:** Click by the Service Indicator Cd and select the service indicator you wish to add. (Notice that some fields automatically prefill, such as User ID and name. Service Ind Reason Cd may automatically prefill, depending on the Service Indicator Code entered.)

**Contact ID:** If you would like to indicate a particular person that the student must see, enter that person’s ID here. If you must search for the ID, click .

Click .

To Delete a Service Indicator

If there is more than one Service indicator for this student, use the **next and previous buttons** to find the one you wish to delete.

Once you have located the correct service indicator for deletion, click the delete row icon . You will be asked to confirm your request. If you are sure you want to delete, click OK.

Click .
View Student Address/Telephone

To view a student’s address or telephone number:

Navigate: Home > Build Community > Bio/Demographic Data > Use > Bio Demo Data

The window below will appear. Enter the student’s ID or use the appropriate fields to search.
The **Bio/Demo Data** screen will appear. Select the “Addresses” tab, to view the student’s address and telephone number. Note: Student ID number can be located on this page as well.

The Address page will appear displaying the addresses and phone numbers on file for that student. Please note that it is possible for a student to have several different types of addresses: mailing, home, business, etc. The address type you are viewing is indicated in the “**Address Type**” field. To change the address type, click the **Next Row** button.
Telephone numbers can be viewed by clicking **Phone** and the student's email address can be viewed by clicking **Email Address**.
UNO Class Roster

To view students enrolled in a particular class, navigate Home > UNO Student Records > UNO Student Records > Inquire > UNO Class Roster.

Find an Existing Value

Academic Institution: [UNOLA]  
Term: 0800  
Subject Area: [URBN]  
Catalog Nbr: 4000  
Description:  
Class Nbr:  
Course ID:  
Course Offering Nbr:  
Class Section:  

[Search]  [Clear]  [Basic Search]

Academic Institution: Will default to UNOLA  
Term: Enter the four-digit code for the semester of the course you’re looking up. If unknown, click the lookup icon to find the correct semester.  
Subject Area: Enter the subject area abbreviation of the course (for example ENGL for English). Do not enter the catalog number (for example 1157) at this point. If the course abbreviation is unknown, click the lookup icon to reveal a list of all the subjects and their abbreviations.  
Catalog Number: Enter the catalog number of the course (for example 1157 for ENGL 1157).  
Click Search.

The bottom window will display all sections of that course for the selected semester. Select a section to access the UNO Class Roster page.
The **UNO Class Roster** page will be displayed.

The data is sorted alphabetically by last name.

**To copy and paste a class roster into Microsoft Excel:**

1. Highlight the roster by clicking and dragging. If you wish to copy all of the information on the page, hold down the CTRL key while pressing the A key.
2. Press CTRL and C simultaneously to copy the grid.
3. Open Excel, click inside an empty cell, right click on your mouse and paste or press CTRL and V simultaneously to paste the grid.
4. You can now widen, narrow, delete or sort the columns as desired.
Importing a Class Roster into Microsoft Excel

Once you have selected and copied (CTRL + C) the roster from PeopleSoft, open Microsoft Excel by clicking Start > Programs > Microsoft Excel.

Once Microsoft Excel opens, click File > Page Setup.

In the Page Setup window, under the Page tab, select Landscape as the orientation for the page and click OK.
Now click **Edit > Paste.**

The roster you copied from PeopleSoft will now be pasted into this spreadsheet.
If there are any columns that you wish to delete, you can click the column header (the letter at the top of the column) of the column you wish to delete, right click your mouse, and select delete. (In the example below, column I has been deleted.)

In addition, the column widths may not be correct for the data contained therein. To widen or narrow the columns click on the line between the column headers (the capital letters above the columns) and double-click your mouse. This will auto-adjust the columns to the appropriate width.
To add a header or title to your spreadsheet to identify this roster, click on the **row number** of the first row (1) to highlight the entire row, **right-click** your mouse and select **insert**.

There is now an additional row at the top of your spreadsheet. A title or description can be entered in that row.

You can also add rows or columns as desired, for attendance, grading or other purposes.

When you have completed all the necessary changes, remember to **save** your spreadsheet as an Excel file.